OpenOPAC
Training & User Guide

Last Updated: 5th May, 2017
<table>
<thead>
<tr>
<th>TABLE OF CONTENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>OVERVIEW .......................................................... 7</td>
</tr>
<tr>
<td>What is OpenOPAC? .................................................. 7</td>
</tr>
<tr>
<td>Some of the main features of OpenOPAC: ......................... 7</td>
</tr>
<tr>
<td>OPENOPACS DESIGN .................................................. 8</td>
</tr>
<tr>
<td>Home ............................................................... 8</td>
</tr>
<tr>
<td>Query ........................................................................ 8</td>
</tr>
<tr>
<td>Information ........................................................... 8</td>
</tr>
<tr>
<td>Search ...................................................................... 8</td>
</tr>
<tr>
<td>Search extras ............................................................ 8</td>
</tr>
<tr>
<td>Query ........................................................................ 8</td>
</tr>
<tr>
<td>Filters ...................................................................... 8</td>
</tr>
<tr>
<td>Result List ............................................................... 9</td>
</tr>
<tr>
<td>My Account / Configuration ........................................ 9</td>
</tr>
<tr>
<td>Help ........................................................................ 9</td>
</tr>
<tr>
<td>Login / Logout .......................................................... 11</td>
</tr>
<tr>
<td>Join online ............................................................... 11</td>
</tr>
<tr>
<td>Language Flag ........................................................... 11</td>
</tr>
<tr>
<td>CONFIGURATION ......................................................... 12</td>
</tr>
<tr>
<td>Initial Configuration and uploading of records from the Database ........................................... 12</td>
</tr>
<tr>
<td>Upload ....................................................................... 13</td>
</tr>
<tr>
<td>Other Configuration .................................................... 14</td>
</tr>
<tr>
<td>Supervisor Settings within Amlib ................................... 14</td>
</tr>
<tr>
<td>Internet Settings ........................................................ 14</td>
</tr>
<tr>
<td>OpenOPAC Settings ...................................................... 15</td>
</tr>
<tr>
<td>Logging in as an Administrator ....................................... 15</td>
</tr>
<tr>
<td>Reset administrator password ........................................ 15</td>
</tr>
<tr>
<td>Colours ..................................................................... 17</td>
</tr>
<tr>
<td>Choosing a Colour Scheme ............................................ 17</td>
</tr>
<tr>
<td>Creating a New Colour Scheme ...................................... 17</td>
</tr>
<tr>
<td>Visibility ................................................................. 21</td>
</tr>
<tr>
<td>Visibility (mobile) ....................................................... 22</td>
</tr>
<tr>
<td>Parameters ............................................................... 23</td>
</tr>
</tbody>
</table>
Email ......................................................................................................................... 56
Email Current View ................................................................................................. 56
NEW IN LIBRARY .................................................................................................... 58
MY CART .................................................................................................................. 59
HELP ......................................................................................................................... 61
Version (found at the bottom of the Help screen) ....................................................... 62
MY ACCOUNT .......................................................................................................... 64
Borrower .................................................................................................................. 64
Details ....................................................................................................................... 65
Items on Loan ........................................................................................................... 65
Renewals .................................................................................................................. 65
Reservations ............................................................................................................ 67
History ...................................................................................................................... 68
Financial transactions ............................................................................................. 68
Saved lists ................................................................................................................ 69
Saved queries .......................................................................................................... 71
Requests ................................................................................................................... 72
Interaction of Amlib with OpenOPAC - once request is submitted ......................... 74
Orders ....................................................................................................................... 76
Borrower details ...................................................................................................... 77
Account options ...................................................................................................... 80
Print Options ........................................................................................................... 80
Print Account ......................................................................................................... 80
Print Loans ............................................................................................................. 80
Print Reservations ................................................................................................. 80
Print History .......................................................................................................... 81
Print Financial Transactions .................................................................................. 81
Print Saved Queries ............................................................................................... 81
Print Requests ....................................................................................................... 81
REVIEWS ................................................................................................................. 82
JOIN ONLINE .......................................................................................................... 84
Settings required ..................................................................................................... 84
Join Online Process ................................................................................................ 84
Which CHANGES ARE INSTANTANEOUS and which ARE NOT ......................... 88
Changes that are instant ......................................................................................... 88
What changes are NOT instant and requires a service to update records ........................................ 88
Location as filters for items [left-hand side] .................................................................................. 90
REPORTS ................................................................................................................................. 91
Statistics Reports ....................................................................................................................... 91
Successful and Unsuccessful Searches ......................................................................................... 92
Opac User Queries ..................................................................................................................... 93
APPENDIX 1: Supervisor settings you must set when you use OpenOPAC ................................. 94
Supervisor Settings ................................................................................................................. 94
Explanation of Supervisor > Installation > Other Settings ......................................................... 94
APPENDIX 2 - COOKIES ........................................................................................................ 96
Use of Cookies: .......................................................................................................................... 96
APPENDIX 3: Language control of browsers via IIS settings ...................................................... 97
APPENDIX 4: FORCING COMPATIBILITY MODE IN IIS7 ....................................................... 98
IIS 7 and IE 7-9 .......................................................................................................................... 98
IIS 7 and IE 10-11 ....................................................................................................................... 99
APPENDIX 5: TO HAVE A PUBLIC [EXTERNAL] FACING OPENOPAC ................................. 100
APPENDIX 6: Customising Colours .......................................................................................... 102
For setting colours in OpenOPACS – to match your logo and colours – creating a new Theme .... 102
To get your correct colours from your logo or banner ................................................................ 102
APPENDIX 7: CUSTOMISING A HOME PAGE ....................................................................... 103
Configuration ............................................................................................................................ 103
Steps in the Process .................................................................................................................. 104
Change the Image ..................................................................................................................... 104
Changing the Text ..................................................................................................................... 105
Table Menu .............................................................................................................................. 107
Cell ........................................................................................................................................ 108
Rows ....................................................................................................................................... 108
Columns .................................................................................................................................... 108
Save the Home Page .................................................................................................................. 109
Source code for Home Page ....................................................................................................... 110
OVERVIEW

This manual provides a basic overview of the OpenOPAC, the settings available from within the Amlib Client and some of the basic customisations available for your OpenOPAC screens.

What is OpenOPAC?

The Amlib OpenOPAC is a web-based OPAC used to search your Amlib catalogue records. Amlib OpenOPAC can be used as an alternative to your Amlib NetOpac.

OpenOPAC is a local server solution which is installed on your local server with its own search engine and a separate database populated from an initial load from Amlib. Once implemented, the database is self-managing with direct updates from Amlib so that availability and status information displayed is current and reliable at all times.

Some of the main features of OpenOPAC:

1. Use filters to drill down and refine search results. The new results are instantly returned as soon as an option is selected or deselected
2. You can Save items from search results, in several ways:
   a. Create saved lists of items
   b. Save search queries—useful if patrons have used set filters and want to run the search again in the future
   c. User can email results to themselves
   d. The current screens can also be printed
3. Data maintained with direct updates from Amlib
4. Mobile Version available – there is an option to view the site as a Desktop or Mobile version, and what is chosen is remembered on that device
5. Easy to customise interface using Configuration Manager
6. Tailor fields that are displayed for bibliographic records and search result screens
7. Search facilities and how to search on OpenOPAC can be found via the Help Menu
Home

Query
Allows for a Basic Search
Enter the Search term and click Search Catalogue button

Information
Optional – can be left blank or edited to be customised in the Administrator/Configuration area / Custom Text with site specific details, images and links as required

Search

Search extras
Includes:

- Recent Activity
- Print – Save
- New in Library
- Cart
- Lists

Query
Basic and Advanced Search

Filters
Where the facets of the Results show so that the search can be filtered
Result List
Displays the results of the Search

My Account / Configuration
Log in with a Borrower Barcode to display details of the Account
Log in with Administrator to set Configuration

Help
The Help Menu contains useful topics for Searching and checking an Account

There are 2 Help Views:

1. If not logged in, or logged in as a Patron the Help is general. Displays:
   - Index
   - Content
   - Cookies
   - Version
2. The Help Menu changes once logged in as Administrator to give assistance in setting the Configuration.
Login / Logout

At the top right hand corner, a Login Link is visible, so a patron can log into their Account. They have to be logged in to Reserve items (if permitted. They can also Login using My Account TAB

Join online

If set as a parameter, click to Join online as a Temporary member. The process is described latter in the document

Language Flag

When OpenOPAC is logged in, a Language Flag will display in the top right hand corner

1. Select the Flag
2. A list of options displays
3. Click the most relevant flag for the correct display of language and symbols for currency
4. This flag will display in the top right hand section
5. The language is dictated by the browser language settings, so if you find it has reverted back to the US Flag, this means you will need to change the language on the Browser, to keep the Australian regional settings.
6. If you are in an institution and need to control this language setting globally across numerous browsers/PCs then this can be controlled by your IIS settings [ see Appendix 3 - Language control of browsers via IIS settings]
CONFIGURATION

Once OPENOpac has been installed there are several settings that need configuration in the Amlib Client and OpenOPAC to ensure that OpenOPAC updates when records are altered or new records are added:

1. Default Amlib/Supervisor settings to set for OpenOPAC
2. Internet Settings
3. OpenOPAC Settings within Configuration

Initial Configuration and uploading of records from the Database

1. This is part of the OpenOPAC installation Notes.
2. After the initial installation of OpenOPAC has been done it is necessary to set the Marc Tags required and upload the Catalogues so that Searching can be done.
3. Open the browser window that has been installed.

4. To Log in as the Administrator

Select > Log In
Username: Administrator
Password: 1234 [this is the default PIN, but we recommend that this be changed after installation is complete]

Marc Fields
1. Go to the Configuration tab > select Marc Fields > then set them and select > SAVE
Choosing the Marc fields will have ramifications as how the Search results are displayed – for example. Having 245a,245b (to get just the Main Title and Subfield if it exists) or 245 (to get all the Subfields included) ...

Tag 245:

The ivory swing [electronic resource] / Janette Turner Hospital ; read by Lise Rodgers.
Tag 245a,b

The ivory swing

Upload

1. From Configuration Tabs, select Upload
2. Start the Upload Data process. Try one Catalogue item upload first. Please specify a valid catalogue ID before you start the upload process.
   Please note that the stock item must be set to Opac? = Y and the catalogue must be set to Opac View Restriction = N.
3. Select on the Upload tab and enter a valid catalogue reference number from Amlib and try uploading one catalogue [ must do this TEST first to ensure all is correct]

   Upload one Catalogue:  
   
   Please wait while the process executes
   
   The process will notify on success
4. Start the upload of **Upload all Catalogues**

If the single Catalogue completed successfully, the process to upload all catalogue items can be started. This may take between 10 and 60 minutes, depending on the number of catalogue records and the performance of the server.

5. Start the upload of **Master data** (takes about 2 minutes)

6. Start the upload of **Suggestions** (about 15 - 20 minutes)

7. Open is now configured and ready for use – with its default settings

**Other Configuration**

1. Log in as an Administrator on OpenOPAC and set customised Configurations for OpenOPAC, including Home Page, Theme colours, image, Library name, searches, the screen displays and all the settings required for their library. See relevant sections in this Guide

**Supervisor Settings within Amlib**

Go to Main/Supervisor/Installation/Default settings/Other TAB. Scroll down to the parameters beginning with OPEN.

- The most important parameter is OPEN Web Enquiry enable. This must be set to Y if using OpenOPAC.
- Other settings in Installation will be described later in the Guide. If offering JoinOnLine, there MUST be a default Borrower Type and Status set in the parameters. Otherwise this cannot be used.

**Internet Settings**
1. Controlling Language and Regional Settings – see Appendix 3 – ensures that the currency and dates display correctly
2. Turn Compatibility Mode Off: In some browsers, specifically IE (Internet Explorer) this is required to get OpenOPAC to display correctly. See Appendix 4.

OpenOPAC Settings

Configuration is available once the Administrator has been logged in using the Login Button near the Flag.

Logging in as an Administrator

1. In the upper right hand section of OpenOPAC select Login
2. The Login box will display
3. Enter the User ID of Administrator
4. Enter the Password of 1234 (it is possible to alter this later for security reasons)

Note: The Login and Passwords are case sensitive

Reset administrator password

1. When logging in as Administrator
2. An option to Reset administrator password is possible via a link
3. A Reset box will display
4. Enter the answer to the Security question in the Security answer field
5. If correct the password will be reset to the default.
6. It can be later changed in the Configuration/Security Tab
**Note:** You can select the checkbox “Remember user name on this device, if appropriate, so it remembers the username if using your own PC or Mobile device

**Note** when signed in as an Administrator, when you conduct searches and look at the bibliographic record you will notice you can see the catalogue reference number.

This is never viewable to patrons whether they are logged in or not.

Once signed into Administrator a series of TABs will display. These include:

1. Colours
2. Visibility
3. Visibility (mobile)
4. Parameters
5. Enrichment
6. Marc Fields
7. Format groups
8. Search
9. Custom text
10. Upload
11. Security
1. The full entry window will display where the colour can be changed for each of the segments as required.
2. Ensure the New name is displayed at the top of the Colour Scheme colours before customising

Colours
To view the current scheme colours, change the scheme, create a new scheme or delete a scheme. See also Appendix 6 for more details

Choosing a Colour Scheme
1. Once logged in as Administrator select the Colours TAB

1. The Colours page will display where a predefined Colour theme can be chosen from the Colour scheme dropdown
2. Highlight the colour to choose
3. Select Save at the base of the screen to update the settings. The colours will then change when the page is refreshed
4. If you select New you can base it on one of the created themes and just change a few of the colours if desired
5. A confirmation message will display at the top of the Window

Creating a New Colour Scheme
It is possible to create a scheme that is not one of the predefined themes and may suit your site better. Please see Appendix 11 for some hints on how to achieve the right colour hue
3. Click the **New** button

4. Enter the new **Scheme Name**

5. Enter the “Scheme is based on template” from the Drop-down options if required (if a Scheme is close to a predefined Colour scheme. You can select a template to base your design on an existing template and get a starting point for the colours or you can start from scratch. If starting from scratch, the scheme can be based on the template **None**

6. Click **Continue**

**Note:** To assist in determining the correct section for each colour, a diagram explaining which each section is available on that window. Click to enlarge the image for clearer viewing
7. The Numbers on the left hand-side of this screen correspond with the Numbers within the diagram
8. Click in the Colour Value box to change and customize the colour
9. A Colour Wheel will display
10. Click on the wheel to select the Colour
11. The Hex Colour value will automatically display in the box
12. Click Close to select that colour value
13. Click Save at the base of the window to save the Colour Scheme

Please note: After saving, some browsers keep the old colour settings in the cache. Clearing the browsers cache will prevent this (for most browsers pressing Ctrl F5 will do this)
Visibility

1. Once logged in as Administrator select the **Visibility** TAB

2. There are 4 lists to configure:
   - Search result list – the first listing of results
   - Search result list – copies
   - Details view (bibliographic view)
   - Details view – copies

3. **Tick** the boxes to determine which details show on the search result list and in the details list. The unchecked ones are hidden

4. Click **Save** once complete

**Note:** the fields that have * next to them are being used for searching, so it would be confusing for users to hide those fields

**Note:** the items that have ** next to them are the fields being used for filtering
Visibility (mobile)

NOTE: Only select the most important options for your library, to get an optimal display on mobile devices.

From this screen you are able to set up what the users will see on their Mobile devices, and how your records will be searched and displayed.

1. Once logged in as Administrator select the Visibility (Mobile) TAB
2. There are 4 lists to configure:
   - Search result list – the first listing of results
   - Search result list – copies
   - Details view (bibliographic view)
   - Details view – copies shown under the bibliographic record

3. Tick the boxes to determine which details show on the search result list and in the details list. The unchecked ones are hidden
4. Click Save once complete
Parameters

This configures the setting of parameters for:

- **OPAC options**
  - Name and logo
  - Sort options
  - Default settings – Join online, show suggestions, show reviews, allow reservations etc.
- **SMTP details** – set up email settings required to allow emails to be sent from *OpenOPAC*

---

**OPAC Options**

1. Once logged in as Administrator select the **Parameters** TAB
2. Scroll down to the **Opac Options** section
This enables the entry of:

- **Library Name**
  
Enter the **Library Name** in the box. This will then display on the side of the Main Screen of *OpenOPAC*

  ![Library Name Input Field](image)

- **Default Sort Order**
  
  Enter the **Default Sort order**: Choose from the options in the dropdown box

  **Note**: Relevance is the recommended Sort Option for the default. This is ranked by whether the Search Terms appear anywhere in the Amlib bibliographic record. Search terms appearing in the Title, Author or Subject field are ranked highest. The combinations of the term is then ranked on a scaling system for the presence of the terms and the proximity of the terms to each other

  ![Sort Options Dropdown](image)

- **Log Level**
This should be set at **WARN** unless this setting has been requested to be changed by Support staff at OCLC, to create a detailed log file to investigate an issue or error being reported. The **Log Level** specifies the amount of details in the log files.

- **Download Current Log File**
  
  Use this option to upload the latest Log File. Usually only used if Amlib Support asks for a Log regarding a problem that needs resolving.

- **Join Online**
  
  Tick **Join online** if you wish to allow this facility.
  
  If you wish to allow Join online the parameters need to be set within Supervisor, Installation, Other for the relevant Locations.

The Text for the Terms and Conditions should also be set in the Configuration settings of OpenOPAC with the Administration set up.

The SMTP settings will also be required as the new borrower will receive two emails in the process.

- **Allow Reservations of catalogue items**
  
  Tick **allow reservations** if you wish to allow users to reserve all items for a catalogue. The Reserve will then be placed as a First available for all copies of the Catalogue.

- **Allow Reservations of stock items**
  
  Tick **Allow reservations of stock items** if you wish to allow reserves on individual items. This is important if you wish to allow reservation of individual Periodical/Magazine issues that may share the same Catalogue as the Main entry Catalogue.

- **Allow Renewal**
  
  Tick **Allow Renewal** if you wish to allow users to renew items currently on loan (Subject to the circulation and Supervisor/Installation/Other/OpenOPAC rules set – whether they owe money, have overdues etc.)

- **Allow change patron details**
  
  Tick **Allow change patron details** if you wish to allow users to alter the Patron details.
* This includes being able to change their personal details and their PIN online when they are signed in OR you can turn this option off so it’s not possible for them to change personal details and their PIN

Any Online changes can be followed up by Library Staff, by checking the Online Changes table for review

- **Allow Requests**

  Tick **Allow Request** if you wish to allow users to be able to request ILL or Purchase Requests. Click the Drop-down box to choose which option is required:

  Allow requests
  
  Show copy information collapsed
  
  Show suggestions:

  * All (Purchase Requests as well as Inter Library Loans)
  * Inter Library Loans (Inter Library Loans Only and not Purchase Requests)
  * None (No Purchase Requests and no Inter Library Loans)

- **Show Copy Information on initial search**

  The Copy or Holdings can be hidden (collapsed) so that it only shows once the Title or Show Copies is selected. If the parameter is ticked, the Copy information is hidden until selected

  Alternatively, Copy information can be shown when the search is first completed. If the parameter is unticked, it displays on the initial window

  ![Copy information](image)

- **Show Suggestions**

  Tick **Show suggestions** if you wish to allow users to see suggestions from what other items have been popular or searched for recently

- **Show Reviews**

  Tick **Show reviews** if you wish to allow this. Reviews are from Good Reads, patrons can join up to Good reads, so they can submit their own reviews if they wish or just read the ones provided by Good Reads.
OpenOPAC Manual - Training & User Guide

Adding a LOGO

1. Click the Browse to find the Main Logo Image if required. Once found, click Upload to select

   ![Upload Image](image.png)

   **Note:** The size of image is important for optimal resolution and display. The Image can be a jpg, gif, png Image file and should be less than 0.5 Mb (better: less than 20 Kb) and is converted to **340 x 117 pixels** – This size fits the placeholder best. Sometimes your logo is not rectangular, so it may be preferable to create a rectangular one in Paint NET, and put more background colour behind it. Click Save at the base of the screen after setting the OPAC options

   - **Currency Symbols**

     Set the Currency symbol to reflect the correct currency displaying on the **My Accounts** screen.

   ![Currency Symbol](currency_symbol.png)

SMTP Options

If patrons will be able to email their search results or queries to themselves, after conducting a search on **OPENOPAC** the SMPT and Email Options will need to be completed

1. Once logged in as Administrator select the **Parameters** TAB
2. Go to the **SMTP Options** section
3. Enter the **SMTP host** name or IP address
4. Enter the **SMTP Port**
5. Enter the **SMTP User Name**
6. Tick if **SMTP Enable SSL** is to be enabled: This allows for the SMTP Client using a **Secure Sockets Layer (SSL)** to encrypt the connection for your email. If you want an unencrypted connection **DO NOT** tick the **SMTP ENABLE SSL**
7. Enter the **SMTP email address**
8. Click Save at the base of the screen after setting the OPAC options

![SMTP Options](smtp_options.png)
Enrichment

An enrichment provider can be selected if subscribed, as well as the additional elements from that subscriber depending on the level of subscription.

Up to two providers can be entered and one chosen to use for Cover images.

Enrichment providers may be:

- None
- LibraryThing
- LibraryThingFree
- SyndeticsPlus
- LocalStoredImages

If a match is found for the Cover image, the images will display automatically.
1. Select the Enrichment Provider from the Dropdown options

2. Tick the Use for Covers if appropriate

3. Enter the Parameters depending on the Provider selected
   a. Use the Click here to maximize/minimize help text to copy and paste in the requirements
      For example: for Syndetics enter the `SyndeticsPlusClient=.....` (the Client Number) in the Parameter box and the `htm` relevant to the elements to which your library is subscribed, in the **Content to be shown** box. This will vary between sites.

Subscribed Enrichment Provider
Includes:

- LibraryThing: Apply for a Dev Key if subscribed directly from LibraryThing
- LibraryThingFree: Option to provide free Book Cover Images – subscribed directly from LibraryThing which will also require a Dev Key in order to show covers
- Syndetics Plus: Contact support-anz@oclc.org for the code is required for Syndetics

Local Images

1. These can include SCIS images as well as added images and other pdf files attached to catalogue records. See other documents on setting up a shared Image Path in Amlib/Supervisor/Installation to store the images
2. When setting up in the Enrichment Tab of OpenOPAC, leave the parameters box blank.
3. If to be used for Cover images, tick Use for Covers option
   
   ![Local Stored Images](image)

4. If not to be shown as cover images, they will display at the base of the Catalogue record [you may to ensure you have Pop-up Blockers turned OFF]

5. Clicking any Image or pdf will enlarge the image and show separately
6. If not using another provider the first image you have attached can be used as a book cover image on both the result list & Bib record by selecting the use for cover option

SCIS (Education Services Australia) have Cover images available. The Images.zip file contains images for items matched in the Order file (Note: Not all SCIS records have cover images).

The Images.zip file can be saved, extracted and attached to the Catalogue data in Amlib as an Image attachment. The image is not part of the Marc file so the image will need to be added individually to each catalogue record, after the Marc file has been downloaded.

Note: To alert your patrons to images being attached on the Catalogue record, it is possible to allow notes to be seen on the results view. Then add 'see attached images' in your catalogue records to a 504 marc tag or one of your 500 tags - which you have selected in the marc fields tab in configuration.
Marc fields

Define the Marc Tags for searching and filtering. The Default Tags are shown in grey to the right, but can be modified. Specific subfields can be identified, for example it works better if only the ‘a’ and ‘b’ subfield of the 245 tag are entered to display, rather than the full 245 tag (due to punctuation)

**This should be done as part of the initial Installation**

1. Once logged in as Administrator select the **Marc Fields** TAB
2. The Marc field mapping window will display
3. Modify the relevant boxes as required. A full Stop is placed between each Marc Tag if more than one Marc Tag is identified
4. Click **Save** when complete

![Marc field mapping](image)

**NOTE:** This needs to be set in place before the first initial load of Catalogues so the records display as required [see OpenOPAC installation guide].

Select > the **Marc Fields** tab and add the Marc Tags you want to display. There will be some default ones already in place that you can remove or you can add more, depending on your own records and what you want displayed.
**Note:** Some tags have an * next to them, this means that these are the ones being used for searching and returning results

**Note:** Some tags have ** next to them, that means these tags are being used for filtering purposes, so keep this in mind when selecting what tags you wish to be displayed
Format Groups

It is possible to group the Amlib Form codes into broader Groups so that the Result Filter on the Left-hand side of OpenOPAC displays the Groups defined.

An automatic load of the Form codes used in Amlib displays in the Format window.

1. Once logged in as Administrator select the Formats TAB
2. The Form codes used in Amlib will display
3. Enter the required Format in the box to the right
4. Click Save when complete

Once this has been set when searches are performed in OpenOPAC, the Format Filters on the left reflect these categories
If **ALL** the categories are to be cleared select the **Delete All** button on the right.
Search

A preloaded set of common synonyms are available as a default. It is possible to add other words to improve the results of returned searches. For example: computer game, Wii games, Play station, Nintendo – Any of these will be returned if one of these words are typed into a search.

Synonyms

Once logged in as Administrator select the **Search TAB**

The **Synonyms** window will display
Add extra lines of searching terms as required. It does not matter where the lines are added. Enter a comma between terms.

Please note this is not a ‘see and see also listing’, it just allows synonyms to be search to increase the search results when one term is used rather than another.

For example you may like to add these:

aeroplane, airplane, airliner, aircraft, plane, airship

lift, elevator, escalator

gb, gib ,gigabyte ,gigabytes

mb, megabyte, megabytes

Television, tv

Click Save when complete

Stopwords

Enter words that are not required for searching. These words are filtered out from the Search Index and result so that unnecessary targets can be avoided.

Words can be added or removed from this list, but care needs to be given due to repercussions of this action.

Click Save when complete
Custom text

This configuration allows for:

- The Home page can be configured to include Site specific details and images
- Default text determined to be used when patrons join online.

Home page text:

This is used set up a home page with a specific image, information, location of branches, opening hours etc…

This will appear in the Home page TAB before a search is conducted.

- an image of the library or a location map etc
- Details about the library & opening hours
- Contact details
- Other links to social media if required

Hint: select View > Show blocks as this will show you where you can sit your text & images, as its HTML coded in the background – you can switch to HTML code by selecting Tools, if you are familiar with this instead.

Terms and Conditions

The terms and conditions for the library membership can be typed into this space.
This is used when if patrons can join online. The terms and conditions can be agreed upon, prior to allow the patron to join online.

1. Click in the Terms and Conditions for new patrons box
2. Enter the Text required
3. Formatting can be used to change Font sizes, change colour and align
4. Click the Save button when completed
The new Patron will need to select this agreeing to the terms & conditions.

I have read and agree to the Terms and Conditions.
Upload?

Upload new or changed Catalogues to OpenOPAC as well as changes to Codes and Parameters.

**Upload all Catalogues:** Used when installing OpenOPAC initially, or when you have had a major change in your records and want a fresh uploaded catalogue in OpenOPAC.

**Upload only changed Catalogues:** When catalogue changes are made and the changes are to be available in OpenOPAC immediately, not waiting for the automatic service to do this which is about a 15 minute delay.

**Upload one Catalogue:** Used mainly for the first time when installing OpenOPAC, as a check to ensure services and everything is connected and working correctly. It can also be used to ensure that the Catalogue changes for one Catalogue are to be found in the results immediately rather than awaiting the automatic service.

**Clear Search Index:** Only used if you want to completely clear everything in OpenOPAC & reload all records again by using the initial upload [Upload all Catalogues].

**Upload Masterdata:** If codes are created or modified, in Amlib to Locations, Form codes, Site codes, Status etc. this will allow these to be used and displayed within OpenOPAC. Also restart your IIS service for changes to appear.

**Upload Suggestions:** If ‘Similar items’ option is set in Administrator, this will load these into the OpenOPAC.

**Reset Memory:** This clears all cached values, effectively causing the values being reread from Amlib. Values like Masterdata, Circulation settings, parameters etc. Used when you have made changes to this type of setting within the Amlib client.
Reset memory.
Security

Security Question

1. Enter the security question
2. Enter the security answer
3. Click Save

This will be required if the Administrator password is to be reset at login

Change the Pincode

1. Click Change Pincode to change the Administrator password
2. Enter the current PIN
3. Type in the new PIN
4. Type in the PIN again to Confirm PIN
5. Click Save
USING SEARCH OPTIONS

Quick Search

1. Enter a few significant keywords from your Title, Subject, etc. into the Query box and then the click **Search Catalogue** button
2. To see more information about a specific item, click the hyperlinked title
3. Once you begin to type a common word into the query box, you will be given a list of prompts to save you typing and assist in spelling

4. To narrow down your search results, use the Minus symbol between terms `-` or **NOT** to exclude words. For example Paris – Fashion or Paris NOT Fashion.
5. Use **OR** to combine search words. This will get many more results
6. If you want to search for specific words found together use apostrophes around the terms. For example, if you wish to find the terms Red and Heart together, use ‘Red heart’
7. Truncation allows the search of a term and its variations by entering a minimum of the first three letters of the term followed by a question mark symbol (?) or an asterisk (*)

Advanced search

1. Click the Advanced Search hyperlink to the right of the Search Catalogue button

2. A Query window will display

3. Click the first drop-down to set the Search criteria
The options are All, , Authors, Contributors, ISBN, ISSN, Notes, Publisher, Series, Subjects, Summary and Title

4. Select an option
5. Boolean Search Operators (AND, OR, NOT) can be used when using multiple Fields. Click the AND drop-down to select other operators as required
6. Filters can further define the search by:
   - **Publication Year**: Enter the beginning and ending Punctuation years
   - **Location**: Select from the drop-down Location options
   - **Collection**: Select from the drop-down Stats codes
   - **Format**: Select from the drop-down Form codes or Format Groups (if configured)
   - **Acquired**: (new item search)

   **Note**: Select as many or as few filters you required

7. Enter the search criteria and click **Search Catalogue** button to view the results
8. Once the results display the Advanced Search options collapse and links are available to:
   - Click here to maximize the Advanced Search View
   - Click Quick Search
8. Or it is possible to select the Home or Search TABs or Click Recent Searches

**Result list**

Defaults can be set in Configuration as to the details visible within the Result list and whether the Copy information is hidden or displayed on the first display of results.

- Visibility view – sets the results for the first screen result view and Catalogue view
- Visibility (mobile) - -- sets the results for the first screen result view and Catalogue for Mobile
- Parameters – sets whether the copy information is displayed or hidden on initial results

1. **Available/Unavailable**: Gives an indication if the items are available to loan.
2. **Show / Hide copies**: Can be set to display automatically in the Result list or click to show /hide copies. The details will also display at the base of the Catalogue information.

<table>
<thead>
<tr>
<th>Location</th>
<th>Floor location</th>
<th>Status</th>
<th>Reserved</th>
<th>Due date</th>
<th>Call number</th>
<th>Collection</th>
<th>Format</th>
<th>Acq</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chelsea Library</td>
<td>DISPLAY</td>
<td>Available</td>
<td>0</td>
<td></td>
<td>J097.8 SLAT</td>
<td>Junior Fiction</td>
<td>Books</td>
<td>26/03</td>
</tr>
</tbody>
</table>

3. **Sort Order**: Click the drop-down Sort order to change the order of the results if required. The default Sort option is generally Relevance. Other Sort options are shown below:
4. **Filters**: Refine the results by using the filters on the left hand side which enables the search to be drilled down successfully. These filters include:

- **Availability**

  ![Availability Filter]

  - Available (102)
  - Unavailable (6)

- **Authors**

  ![Authors Filter]

  - John, Sue. (4)
  - Elliott, Sharon. (3)
  - Griffiths, Andy. (3)
  - Magee, Wes. (3)
  - Chapman, Philip. (2)
  - More (83)...

- **Location**

  ![Location Filter]

  - Chelsea Library (106)
  - Home Library Service (1)
  - Mobile Library (1)
• **Collection: Stats Codes**

![Collections]

- Junior Nonfiction (51)
- Adult Nonfiction (17)
- Community Information (15)
- xxx (9)
- Adult Fiction (7)
- more (4) ...

• **Format: Form Codes** (can be set with Format Groups)

![Formats]

- Books (92)
- DVD kit (15)
- PDF File (1)

With **Format Groups** – set in Administrator/Configuration/Format Groups

- Equipment & Computer (25)
  - Restricted Hardware (14)
  - Hardware (12)
- Print (17)
  - Periodical (16)
  - Photo Album (1)
- Audio Visual & Digital (14)
  - DVD (7)
  - CD ROM (6)
  - DVD notes (1)

• **Subject**
5. **Reserve button**: Displays if set within configuration

6. **+ My Cart button**: Items are able to be selected and added to a Cart using the button.

   Once selected the + changes to a −. To remove Items from your cart while on results list, select the button again and the button will change back to a +

7. **Title**: Click to see Bibliographic and Copy details

8. **Number of records** found for the search term displays at the top of the page showing the number of pages and hyperlinks to the pages

**Location as filters for items**

It is possible to set items with certain Locations to show/not show in Opac.

To determine which Locations can be viewed and which are hidden, the settings within Main > Supervisor > Installation > Other TAB of the Amlib client are checked.

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location is Valid for Holdings</td>
<td>Y</td>
</tr>
<tr>
<td>Location is Valid for OPAC Enquiries</td>
<td>Y</td>
</tr>
<tr>
<td>Location is Valid for Registrations &amp; Circulation</td>
<td>Y</td>
</tr>
</tbody>
</table>
If Location is Valid for OPAC Enquiries, the Location will show. If Location has a Value of “N” then the Location will not be included in the filter and the items hidden from view.

Restart IIS and refresh your browser, to enable the changes to your locations to display.
LOGGING IN

It is necessary to Login to OpenOPACs if you wish to view My Account information or to Reserve items. You also need to be logged if saving any My Cart items to My List.

1. Go to either ‘Borrower Account’ and log in there or choose the Log in link at the top right-hand side of the screen

2. The Log In Window will display

3. Enter your Barcode into User Name

4. Enter if the PIN (if configured to use)

5. Click “Remember user name on this device” if appropriate

6. Click Log in Button

7. The name of the User will display near the flag

8. The details of the Borrower will display with access to the details using TABs in the Details window

RESERVE ITEMS

Depending on settings chosen by the library, you will be able to either reserve ALL copies by selecting the Reserve button next to the title or you may be able to reserve a specific copy of a record by opening the Available / Not Available Hyperlink to access the Copy information and select a trolley to reserve the copy. [If there are no trolley displayed, then you will only be able to reserve by title only]

Note: The maximum number of reservations allowed within OpenOPAC will depend on the Circulation settings as set per Borrower Type in combination with the Form/Stats Code

Reservation Collection Locations

To determine which Locations can be chosen as Collect Locations, the settings within Main > Supervisor > Installation > Other TAB of the Amlib client are checked.

| Location is Valid for Holdings | Y |
| Location is Valid for OPAC Enquiries | Y |
| Location is Valid for Registrations & Circulation | Y |
The one that it checks is “Location is Valid for Registrations & Circulation”

NOTE: if you already have OpenOPAC installed when you make these changes or before you upgrade to the latest version, you will need to access Configuration select the Initial Load tab and do the following:

Upload Catalogues, load Masterdata

Restart IIS and refresh your browser, to enable the changes to your locations

To reserve all copies

1. Ensure that you are logged in, which is necessary to Reserve items – if not, a pop-up box will display

![You have to login to place reserves](image)

1. Find the record that you wish to reserve the first available copy

2. Click the Reserve Item button ![Reserve](image) to reserve the first available copy

3. The Select Pickup Location box will display

![Select Pickup Location](image)

4. Select the relevant location from the drop-down Available Location box

5. Click Continue

6. If successful a confirmation will display and if a charge is due it will also show in the message

![Reservation successful: Reservation charge of $5.00 added to account.](image)

7. Click Close

Reserve a specific Copy

This option is only available if the Configuration parameter is set to allow Reservation of Stockitems to allow reservation of specific items. This is important when allowing reservations of individual Periodical/Magazine copies
1. Ensure that you are logged in, which is necessary to Reserve items – if not, a pop-up box will display
2. Find the item that you wish to reserve
3. Click the **Available / Not available hyperlink** to access the copy information

<table>
<thead>
<tr>
<th>Location</th>
<th>Status</th>
<th>Reserved</th>
<th>Due-date</th>
<th>Call number</th>
<th>Collection</th>
<th>Format</th>
<th>Reserve</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library Processing</td>
<td>Available</td>
<td>8</td>
<td>F/502W</td>
<td>Julie Filler</td>
<td>Books</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Library Processing</td>
<td>Available</td>
<td>8</td>
<td>F/502W</td>
<td>Julie Filler</td>
<td>Books</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chelsea Library</td>
<td>Reserved</td>
<td>1</td>
<td>F/502W</td>
<td>Adult Fiction</td>
<td>Books</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chelsea Library</td>
<td>Available</td>
<td>8</td>
<td>F/502W</td>
<td>Julie Filler</td>
<td>Books</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chelsea Library</td>
<td>On Loan</td>
<td>1</td>
<td>10/08/2085</td>
<td>F/502W</td>
<td>Julie Filler</td>
<td>Books</td>
<td></td>
</tr>
</tbody>
</table>

4. Click the **Trolley** in the **Reserve Column**
5. The **Select Pickup Location** box will display
6. Select the relevant location from the drop-down **Available Location** box
7. Click **Continue**

![Select Pickup Location](image)

8. If successful a confirmation will display

![Reservation successful](image)

9. Click **Close**
RECENT ACTIVITY

To return to your original search result after conducting other searches and selecting filters and/or hyper-links to related records use Recent Activity to find the original search.

1. From the main Search Window select Recent Activity. The number of searches and other activities for the session displays in brackets

![Recent Activity](image)

2. The Recent Activity list is displayed

![Recent Activity List](image)

3. By clicking on one of the entries, the search is re-executed and the search results list displays

PRINT - SAVE QUERIES

Save Options

From the Print Save button at the Top of the Window there are Save and Print Options

![Save Options](image)

Create Permalink

Save any of the **Queries/Search** results to display as a URL

1. Perform the search
2. Click **Print – Save**
3. The **Save Options** will display
4. Select Create Permalink
5. The Permalink Window will display with an automatically generated URL
6. This can then be copied or pasted to be used later via email etc.
7. Click Close

If necessary, a URL shortener program can be used to keep the permalink in a shorter version than that created

**Save A Query**

Allows the saving of the actual search terms used. If you return at a later date and use this saved query, the exact same query will be run. However there may be more results, if items have been added to the library collection since the last time the query was chosen

1. Perform the search
2. Click **Print – Save**
3. The **Save Options** will display
4. Click **Save Query**
5. Enter the **Saved query name**

6. Click **Continue**
7. The Saved Query can now be accessed from the Cart- Lists – Queries button

**Print Options**

**Print Current View** – from your **Search Result** screen, **My Cart** view and **Bibliographic View**

Also allows the printing of the Results list to a selected Printer

1. Perform the search
2. Click **Print – Save**
3. The **Print Options** will display
4. Click **Print Current View**
5. The **Result List** Print Preview will display
6. Click the **Print** Button to select a Printer

7. Click **OK**

**Email**

**Email Current View**

**Note:**

- Before the facility is available, the configuration for SMTP needs to be set up in the Administrator settings
Ensure you add reprt.exe as an exception to your Virus Program if you have one, so that the email function work.

Allows the **emailing** of the Results list

1. Perform the search
2. Click **Print – Save**
3. The **Print Options** will display
4. Click **Email Current View**
5. The **Result List** Print Preview will display

6. Enter the **Email address**
7. Click the **Email** Button to send the email
   a. If the email was unsuccessful a message will display at the top of the window. It will be necessary to check the Administrator Configuration and your **SMTP** settings

   **Sending email failed: Failure sending mail**

   b. Or if successful

   **Sending email successful**
NEW IN LIBRARY

Recently added items can be viewed by selecting **New in library** button at the top of the OpenOPAC window. Also available in Advanced Search
**MY CART**

It is possible to create a Cart of items to group together to view later. It is not necessary to be logged in to do this. However, to transfer the items from the Cart to My Lists it is necessary to log in.

1. Perform a search
2. From the Results list, click the +Cart button to add to a Cart
3. The Cart at the top of the window will show an increment each time a +Cart item is added

4. To view the items in the Cart click the CART hyperlink at the top of the Window. A summary of My Cart lists along with My Lists and My Queries

1. To view the contents of the Cart click on the My Cart Hyperlink
2. The My Cart Window will display

3. To remove an item from your cart select the –My Cart Button and the item is removed. You will notice that the My Cart total will decrease by one each time the –My Cart button is selected. It will not be removed until My Cart is selected again and it will redisplay with the correct number of items
5. To delete ALL items in the cart, click on the X Delete button at the top of the Window. No confirmation is given. All items will be removed from the Cart

The number of items contained in the Cart will now show as 0

**Note:** Log into **My Account** to create **Saved Lists** from the items in the **Cart**
HELP

Online Help is found on the Main Window.

Details can be found including:

1. **Index** to Help topics
2. **Overview**
3. **Home** (Search) - A guide to **searching** and **strategies** to find relevant items using
   a. Search Guidelines
      i. **Keyword** searching
      ii. **Including** and **excluding** terms
   b. **Quick** Search
   c. **Advanced** Search
   d. Search **Results** List
   e. Search **Details** View
   f. Search **Filters**
   g. Search **Menu** Options

4. **My Account**
   a. What is **My Account**
   b. **Items on Loan**
   c. **Reservations**
   d. **History**
   e. **Financial Transactions**
   f. **Saved Lists**
   g. **Saved Queries**
   h. **Requests**
   i. **Borrower Details**

5. Information about **Cookies** – How Cookies may affect you
6. Information about the current **Version**

1. Click the **Help button** – **How to use this Site**
2. The **Index and Content** details will display
3. **Click the Index** to find specific information

4. The details of the topic will display on the right in the **Contents** section

5. **Use the Previous and Next Arrow Keys** to scroll through the Help Topics or click on a different topic from the Index

6. **Click Cookies** to see how these may affect you – See Appendix for more information

7. **Click Version** to view current Version details. For example

**Version** (found at the bottom of the Help screen)
<table>
<thead>
<tr>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are currently running version 6.3.771.0 from 20/04/2017 9:48:24 AM</td>
</tr>
</tbody>
</table>
MY ACCOUNT

A summary and details will display when My Account is chosen.

Borrower

- Name
- Barcode
- Current loans
- Current reservations
- Outstanding amount – Financials owing
- Current requests
- Memos – Memos can be created in Borrower Details of Amlib with a Show set to O
  - When the Borrower logs into their Account any Opac or Reservation Memos will display

Any memo where “Show” is set to “O” will display in the Borrower’s My Details screen where specified. This includes all automatically generated memos and memos manually input by staff. If there is a memo on a borrower’s record you do not want displayed then use “N” in the show column. If staff want to see it then set this to “Y”
Memo Show
Y = It only shows in the Amlib client as a Pop-up BUT not display in OpenOPAC
N = No Pop-up appears, but is visible in memo list for borrower in the Amlib Client
O = Pop-up in Library AND Appears in OpenOPAC

Details
Details include TABs for:

- Items on loan which includes Renewals
- Reservations
- History
- Financial Transactions
- Saved Lists
- Saved Queries
- Requests
- Borrower Details

Items on Loan
1. Click the Items on Loan TAB to view current Loans
2. Select the Sort by options from the drop-down box
3. Click the Filter button to display the loans in the chosen Sort Order
4. The items will display

Renewals
1. To **Renew** items tick the checkbox/es for the item/s and click the Renew item button. The item may not be renewed depending on Borrower privileges, balance owing, number of days overdue etc.

2. A confirmation message will display if successful

   ![The renewal was successful.]

   a. If the Renewal was unsuccessful, a message will display depending on the reason

   ![Renewal failed: SB002603: Item too overdue to be renewed]

There are three factors to be considered regarding allowing renewals in *OpenOPAC*:

1. Allow Renewals in OpenOPAC Configuration parameters (accessed if logged into Administrator)
2. The **Circulation** parameters
3. The **Supervisor Installation** parameters

**Supervisor Installation** parameters that will control renewals

1. Go to **Main > Supervisor >Default Screen >Installation > Other Tab**
2. Scroll down to the OPEN ....statements

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPEN - Maximum Amount for Borrower owing</td>
<td>20.00</td>
</tr>
<tr>
<td>OPEN - Maximum overdue days for item renewal</td>
<td>100</td>
</tr>
</tbody>
</table>

**Circulation Parameters**

- **Borrower Type** must be allowed to renew items

- **Borrower Types** also limit the number of times someone can renew
- Items may be reserved by another borrower (and therefore unable to be renewed)
- Items cannot be renewed the same day they were borrowed
- Item may exceed maximum number of days overdue

**Please Note:** The **Renew All** option is available when all items borrowed, meet all renew
Reservations

1. Click the **Reservations** TAB to view current Reservations

2. To **delete** a Reservation
   a. Click on the **Reservations** TAB in the **Details section** of MY ACCOUNT
   b. Tick the **Reservations** that you wish to delete
   c. Click the **X Delete Reservation** button
   d. A **confirmation** message will display
   e. Click **Yes** to confirm

3. To **modify** a Reservation
   It is possible to alter the **Pickup Location** for a current Reservation
   a. Click on the **Reservations** TAB in the **Details section** of MY ACCOUNT
   b. Tick the **Reservations** that you wish to modify
   c. Click the **X Modify Reservation** button
   d. The **Select Pickup Location** window will display
   e. Select the Pickup Location from the drop-down list
   f. Click **Continue**
Note: Pickup locations will display for those Locations where Supervisor/Installation/Other Locations are Valid for Registration and Circulation

History

1. Click on the History TAB in the Details section of MY ACCOUNT

2. The History displays but a Filter is available for
   a. Sort Options
   b. A date range

3. Select the Sort By Option from the drop-down box

4. Select the Beginning Date range from a Calendar

5. Select the Final Date range from a Calendar

6. Click Filter to view the History by that Sort order and Date range

Financial transactions

To view the Financial Transactions click on the Financial Transactions TAB
1. Click on the **Financial Transactions** TAB in the **Details section** of **MY ACCOUNT**

![Financial Transactions Table]

2. The details display showing
   a. Total paid
   b. Total charged
   c. Total outstanding
   d. Details of all Financial Transactions

**Saved lists**

It is possible to save the items from a cart to a saved list to revisit at a later date. Everything you save into a list when in your **Borrower Account Detail Screen** will remain in your saved lists, until the lists are deleted or items removed manually

1. **Add items from your Cart by using the + Cart button**
2. Click on the **Saved List TAB** in the **Details section** of **MY ACCOUNT**

![Saved Lists]

3. The Cart will display

![Cart Display]

4. **Create a list by clicking the Create List button**
5. The Select List window will display where a New list name can be entered
6. Click **√Add** to add the New List
7. Create other Lists in the same way as required
8. To transfer the items from the Cart to the Saved List
   a. Select the Saved List from the Drop-down box of Lists – for example Environment
   b. Tick the items from the Cart to be transferred to the Saved List
   c. Click the Add selected item from cart to named list arrow
   d. The items will be transferred to the Saved List

   ![Image of Select List window]

   **Note:** The items remain in the Cart as it is possible to add the same items to multiple Lists

9. To remove individual items from a List
   a. Click the Saved List from the drop-down set of Saved Lists
   b. Tick the items to be removed from the list items on the right
   c. Click the Remove item from cart to named list arrow
   d. The items will be removed from the list

10. To delete a Saved List
    a. Click the Saved List from the drop-down set of Saved Lists
    b. Click the X Delete List button
    c. A confirmation message will display
d. Click Yes to confirm

Saved list(s) has been deleted.

e. Click Close

11. To **rename** a Saved List

   a. Click the **Saved List** from the drop-down set of Saved Lists
   b. Click the **Rename List** button
   c. Enter the New list name
   d. A **confirmation** message will display

   ![Rename list dialog](image)

   e. Click **Rename List** to confirm

   Saved list(s) has been renamed.

   f. Click **Close**

**Saved queries**

To view **Saved Queries** click on the Saved Queries TAB

1. To **delete** a Saved Query

   a. Click on the **Saved Queries TAB** in the **Details section** of MY ACCOUNT
   b. Tick the **Saved Queries** that you wish to delete

   ![Saved queries](image)

   c. Click the **X Delete Query** button

       a. A **confirmation** message will display
b. Click Yes to confirm

**Requests**

Enables the submission of requests for items that the library currently does not hold.

The Request types available are determined by the parameters set in Configuration.

* All (Purchase Requests as well as Inter Library Loans)
* Inter Library Loans (Inter Library Loans Only and not Purchase Requests)
* None (No Purchase Requests and no Inter Library Loans)

The form is available to be filled out and submitted via *OpenOPAC*, which then becomes available in the Supervisor/Opac/OpacSuggest screen to further process and add a Reply

**Create a New Request**

1. Click on the **Request** TAB in the Details section of MY ACCOUNT
2. The Text is shown: “If you have searched our catalogue and cannot find what you are looking for, create a new request and we will try to obtain the item for you. Requests may attract charges. If your request is likely to incur non-standard charges we will contact you before going ahead”

3. Click the **+New Request** Button

4. The Submit Window will display
5. Select the Type from the drop-down box

6. Select Inter Library Loan Request or Purchase Request

7. Fill in the Details
   a. Title – mandatory
   b. Author – mandatory
   c. ISSN/ISBN if known
   d. Form – choose from the drop-down listing:
      i. Book
      ii. Article, Magazine etc.
      iii. Other (Audio, DVD etc.). If selected a Text box appears where the required Format can be entered
   e. Publisher – if known
   f. Publication year – if known
   g. Additional info – if required
   h. Pickup Location – select from drop-down list

8. Click Submit

9. A confirmation message will display
10. Purchase and Inter Library Loan requests can be viewed from My Account/Requests

11. Library responses can be added about the Requests via Supervisor/Opacs/OpacSuggest

Delete Request

It is possible to Delete Request

1. **Tick** the Request to delete
2. Click the **Delete Request** button
3. Confirm the deletion by selecting **Yes** or click **No** to Cancel

4. Selecting Yes will result in a message displaying:

```
Request(s) has been deleted.
```

**Note:** Requests can be deleted in both Desktop and Mobile Versions. If a Borrower goes ahead with the deletion it will be deleted from the **Supervisor > OpacSuggests** window in the Amlib Client

**Interaction of Amlib with OpenOPAC - once request is submitted**

1. Login to Amlib Client
2. Go to **Main > Supervisor > Opacs > OpacSuggests** to check recent requests
3. The **Opac Suggest** window will display where requests can be viewed
4. Click the Request to be viewed at the top of the Window:
   a. Items
   b. Mbr Dtl (member details) – not used for OpenOPAC
   c. Opac – not used for OpenOPAC
   d. Tick UnAnsweredOnly if required

5. Use the F9 Button to arrow through the Suggests

6. Use the XReference Menu to go InterLibraryLoans or Orders

7. A response is automatically created for the borrower which can be edited if required

**Inter Library Loans**

1. The ILL screen is filled out from the details entered on the form
2. The reservation is made for the Borrower requesting the item
Orders

1. The Order screen is filled out from the details entered on the form
2. A message will display for confirmation
3. Click Yes to continue onto Order Header

4. The details from the form are filled into the Order Header
5. Continue filling in the details as required

6. A message will automatically generate in the Response Field of the OpacSuggests
7. The responses will be viewed in the OpenOPAC at next Login

Borrower details

Change My Details

1. Click on the Borrower TAB in the Details section of MY ACCOUNT
   a. Details of Name, Barcode, Address, Phone, Mobile and Email Address displays
2. Click Change My Details to alter information
3. A Change My Details form will display
4. Fill in the form as required and click **Save**

**Note:** Some fields are mandatory. If there are any other compulsory fields not filled in a warning message will be displayed, explaining what is still required, before information can be changed & saved.

**Interaction of Amlib with OpenOPAC – changed borrowers**

1. Any changes made to Borrower details can be viewed in the Amlib client within **Main > Borrowers > Borrower > Application > BorrowerOnline Changes**.

2. Any changes made by Patrons in **OpenOPAC** are shown in **Blue**. Update these borrowers from here once you have checked their changed details by selecting **F3 Update**
3. It is possible to save the changed Borrowers into Files or Skip the creation of Files

- **Note**: New join-online Borrowers do not appear on this table

- To search for all these NEW borrowers, you can also run a ‘Borrower Where’ search for **BarCode** Like TEMP or the **Borrower type** or **Borrower Status** used for these new OpenOPAC Borrowers – for example “W” as a Type or PEND as a Status as set in the Supervisor/Installation/Other parameters

- It is also possible to run or schedule an OPENReports report, to give you a report of new borrowers regularly if you wish.
ACCOUNT OPTIONS

Click **Account Options** to view the Print Options from My Details

Print Options

![Print Options](image)

**Print Account**

1. **Click Print Account** – a Preview will display

   ![Print Account Preview](image)

   2. **Press Print** to send to the Printer or Cancel
   
   3. The Printer options will display

**Print Loans**

![Print Loans](image)

**Print Reservations**

![Print Reservations](image)
Print History

Print Financial Transactions

Print Saved Queries

Print Requests
REVIEWS

Using Goodreads, Book reviews others have written about the items you have chosen OR write your own review on a book you have recently read.

Ensure that if you wish to use Bookreviews the option is ticked in OpenOPAC > Login as Administrator > Parameters TAB: Show Reviews

To View other’s reviews, perform a search

Click on the Title Hyperlink to see the Bibliographic details

If it has Reviews from Goodreads, they will automatically display

To create your own reviews you need to have a Goodreads Account click on Write your own Review. You will be taken to the Goodreads site using an existing Account or sign up for a new Account.
Harry Potter is a work of art. I got quite a fan of it ever since I was a child. The books themselves are beautifully written, and the characters are well-developed. However, the best part of the books is the way they make you feel. They take you on a journey that is both magical and emotional.

In "Harry Potter and the Deathly Hallows," the final book in the series, Harry, Ron, and Hermione are facing a difficult task: to destroy the Horcruxes and stop Voldemort. The story is full of tension and excitement, but it's also a story about friendship, sacrifice, and the power of love.

The book is divided into two parts: section A and section B. In section A, Harry, Ron, and Hermione set out to find the Horcruxes, while in section B, they must destroy them. The pace is fast and the action is intense, but the characters are not just one-dimensional. They have their own doubts and fears, and they make mistakes.

Overall, "Harry Potter and the Deathly Hallows" is a fantastic conclusion to the Harry Potter series. It's a story that will make you laugh, cry, and feel all the emotions in between. It's a must-read for anyone who loves a good adventure story.
JOIN ONLINE

Settings required

Prior to using this, parameters need to be set up in the Amlib Client and Administrator OpenOPAC settings:

1. Check setting in OpenOPAC> Login as Administrator > Parameters TAB: Allow new patrons to Join Online

2. Set up your default text for your terms and conditions in the OpenOPAC> Login as Administrator > Text TAB

3. If set to allow, ensure that the new Online Borrower Status is set in the Supervisor module > Installation > Other Tab > OPEN - Default borrower status - for example PEN (Pending)

4. If set to allow, ensure that the new Online Borrower Type is set in the Supervisor module > Installation > Other Tab > OPEN - Default borrower Type - for example WEB

Join Online Process

1. If an OpenOPAC does not belong to the Library, it is possible to join online to be able to make reservations

2. At the Log In Window click the Hyperlink “Not a library member yet – join online” or Click the Join Online Hyperlink near the Flag

The Log in Window will display where the form can be filled in
Enter **Title** – Mr, Mrs, Ms etc. (mandatory)

Enter **First Name** – Given Name (mandatory)

Enter **Middle Name** (optional)

Enter **Last Name** – Surname (mandatory)

Enter **Street** – Street Address (mandatory)

Enter **City** – Town or Suburb (mandatory)

Enter **State** - (mandatory)

Enter **Phone** – Home phone (optional but must have at least one phone contact)

Enter **Mobile Phone** – (optional but must have at least one phone contact)

Enter **Email address** – (mandatory)

To enter **Date of Birth** - choose the **Calendar**

Select **Male or Female**

[The mandatory fields are hard-coded and not adjustable in current version]

3. Enter **Sex** from drop-down Female/Male option
4. Read and agree to the Terms and Conditions. To view this click the Hyperlink.

   **Note:** These Terms and Conditions are entered by the Administrator in the Custom Text TAB

5. Click Close
6. Fill in the fields required and click **Register now**
7. If the fields are not filled in correctly the mandatory Fields will show in red
8. Fill in any Mandatory fields and click Register now again
9. Select “I have read and agree to the terms and Conditions”

10. Two emails will then be sent to the Borrower:

   a. The first email is to confirm they actually did register online

   Dear Mary,
   you have successfully registered yourself in our library.
   Finish your registration by clicking this confirmation link (or copy and paste in your browser):

   b. The second email will give them a Temporary Barcode which they can use to login to reserve items

   Dear Mary,
   you have successfully created a new (temporary) account in our library.
   Your new user name: TEMP@2445467
   Your new pin code: BS485
   You should change this temporary pin code after logging on the first time!
   Thank you!

**Interaction of Amlib with OpenOPAC – New borrowers**

1. Login to Amlib Client
2. New Borrowers are created in OpenOPAC can be found using a Borrower Where search with parameters of BarCode Like TEMP (or Status LIKE PEND, BorType = WEB, depending on the parameters set), which can then be saved into a File if required.
WHICH CHANGES ARE INSTANTANEOUS AND WHICH ARE NOT

Changes that are instant

1. Most Stockitem changes are instant, for example: adding a new copy to an existing catalogue record if it already has Stockitems; Location; Format; Process
   a. By re-conducting a search you will see the changes made
   b. By logging back in as the Patron to see borrower changes
2. Reservations
3. Circulation /returns
4. Renewals
5. Borrower account updates as actions are performed, if a borrower logs out and back in- they will then be able to see these changes
6. If you delete the last Stockitem

What changes are NOT instant and requires a service to update records.

*Items that appear in this LIST below will need the automatic service to run, before records will be updated and changes viewable OpenOPAC*

1. If a catalogue record is modified, tags added, removed or modified
2. If it’s a completely new catalogue record and a new Stockitem is added
3. If a catalogue record has been deleted, along with the last Stockitem
4. If a Stockitem is created without a catalogue record it won’t be viewable, until a catalogue record has been added
5. All catalogue and the Stockitem must be viewable, if these settings are changed - it will need to be updated by the service before the change takes place
6. If you are deleting the last Stockitem and catalogue record – the Stockitem will be removed instantly and the catalogue record will be unavailable approximately 10 minutes after the change – once the service is run & the records are updated.
   a. If you add a catalogue record but don’t add a Stockitem, it will NOT appear in OpenOPAC until the first Stockitem has been added

NOTE: If you have made one of these changes and you want the change to appear instantly in OpenOPAC......

You will need to log in as the Administrator and select the Configuration area > select Upload tab and do the following:

- Select > Upload only changed Catalogues
- Click Save
- This will force the change – so it appears on OpenOPAC instantly

Other changes & what is required for them to display in OpenOPAC
In Open Opac the facet information [filters] on the left is based on the search results and obtained from the search indexes. This allows the search to be refined using the facet information.

1. If an existing item form, item stats code or location description is changed - You will need to log in as the Administrator and select the Configuration area > select Upload tab and do the following:
   - Select > Clear search index
   - Select > Upload all Catalogues
   - Select > Upload Masterdata
   - Select > Upload Suggestions
   - Select > Save

   This will reload the search indexes and make the updated description available for display in the facet.

2. If a new item form, item stats code or location code is added - You will need to log in as the Administrator and select the Configuration area > select Upload tab and do the following:
   - Select > Upload Masterdata
   - Select > Save

   This will load the new code and description in Open Opac which can be used for selections such as a reservation collect location.

   Amlib only allows deletion of a code if not used by items etc. – therefore the code would have already been removed from the search index via the normal update process such as item updates, deletes

3. To remove the actual code from OpenOPAC - You will need to log in as the Administrator and select the Configuration area > select Upload tab and do the following:
   - Upload Masterdata
   - Click Save

   This will remove the deleted codes from OpenOPAC

4. When you remove the last stockitem and the catalogue record, it will instantly remove the stockitem from OpenOPAC. The title will still be searchable at first – though it will show as being not available. Once the service has run in the background automatically this catalogue record will be removed entirely and not be searchable or viewable.
Location as filters for items [left-hand side]

To ensure the correct list displays here for your patrons – the settings can be the same as you have for your reservation pick-up locations, unless there is one location that is in the library where items are kept that you want your patrons to be able to search, when using the filters – you would then change just that location and this setting below to Y.

If you make this change after installing or upgrading OpenOPAC you will need to log in as the Administrator and select the configuration area > select Upload tab and do the following:

- Clear search index
- Upload all Catalogues
- Upload Masterdata
- Upload Suggestions
- Click Save

Restart IIS and refresh your browser, to enable the changes to your locations to display.

**NOTE:** All other actions: Modifying a stockitem; Adding an extra stockitem; Circulation/Status details of an item or Adding a Reserve either by the Amlib Client or by OpenOPACS are all instantaneous actions and appear immediately in OpenOPAC [as soon as the page is refreshed, the search re-conducted or When a borrower logs out and then logs back in].
REPORTS

Statistics Reports

Statistics can be used to create reports regarding OpenOPAC use. The most commonly used Web Stats Codes used are:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>600</td>
<td>OPEN Search</td>
</tr>
<tr>
<td>601</td>
<td>OPEN Saved Search</td>
</tr>
<tr>
<td>602</td>
<td>OPEN New Items search</td>
</tr>
<tr>
<td>603</td>
<td>OPEN Borrower</td>
</tr>
<tr>
<td>604</td>
<td>OPEN Renew</td>
</tr>
<tr>
<td>605</td>
<td>OPEN Reserve</td>
</tr>
<tr>
<td>606</td>
<td>OPEN ILL</td>
</tr>
<tr>
<td>607</td>
<td>OPEN Join on line</td>
</tr>
<tr>
<td>608</td>
<td>OPEN Request</td>
</tr>
<tr>
<td>609</td>
<td>OPEN Change Details</td>
</tr>
<tr>
<td>610</td>
<td>OPEN Change PIN</td>
</tr>
</tbody>
</table>

All searches from OPEN including Basic and Advanced searches
The searches saved as My Queries
Searches from the New Items window
When the OpenOPAC user accesses My Account
When an item is renewed via OpenOPAC
When an item is reserved via OpenOPAC
Items created as ILL requests
Members joined via the OpenOPAC
Members who have requested ILLs or new purchase suggestions via the OpenOPAC
Members who have altered Address details via OpenOPAC
Members who have altered their PIN via OpenOPAC

These parameters can be checked in Main > Supervisor > StatsParams to ensure the Count is set to Y.

To create a report – for example Summary by Location, Transtype, Year, Month (&stat200.qrp)

1. Access Amlib Client
2. Go to Main > Reports > RepStatistics.
3. Select F1 New
4. Highlight the Template Summary by Location, Transtype, Year, Month (&stat200.qrp) and click Select
5. Type a Description – for example OpenOPAC Statistics 2016
6. Click F3 Save
7. Select F7 Where
   - Choose Trans Type (Issue, Ret), the operator >= and enter 600 in the Box 3
   - Choose Trans Year = 2016, the operator = and enter 2016 in the Box 3

This will find all OpenOPAC statistics for this calendar year

```
Summary by Location, TransType, Year, Month

OpenOPAC 2016

CHELSEA - Chelsea Library

600 - OPEN Search

<table>
<thead>
<tr>
<th>Month</th>
<th>2016</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>February</td>
<td>259</td>
<td>259</td>
</tr>
<tr>
<td>March</td>
<td>275</td>
<td>275</td>
</tr>
<tr>
<td>April</td>
<td>208</td>
<td>208</td>
</tr>
<tr>
<td>May</td>
<td>57</td>
<td>57</td>
</tr>
<tr>
<td>June</td>
<td>144</td>
<td>144</td>
</tr>
<tr>
<td>Total</td>
<td>958</td>
<td>958</td>
</tr>
</tbody>
</table>

601 - OPEN Saved Search

<table>
<thead>
<tr>
<th>Month</th>
<th>2016</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>March</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>May</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>June</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Total</td>
<td>11</td>
<td>11</td>
</tr>
</tbody>
</table>

603 - OPEN Borrower

<table>
<thead>
<tr>
<th>Month</th>
<th>2016</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td>February</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>March</td>
<td>48</td>
<td>48</td>
</tr>
<tr>
<td>April</td>
<td>27</td>
<td>27</td>
</tr>
<tr>
<td>May</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>June</td>
<td>18</td>
<td>18</td>
</tr>
<tr>
<td>Total</td>
<td>120</td>
<td>120</td>
</tr>
</tbody>
</table>

604 - OPEN Renew

<table>
<thead>
<tr>
<th>Month</th>
<th>2016</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>March</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>June</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Total</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

605 - OPEN Reserve

<table>
<thead>
<tr>
<th>Month</th>
<th>2016</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>March</td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>April</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>June</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Total</td>
<td>36</td>
<td>36</td>
</tr>
</tbody>
</table>
```

Successful and Unsuccessful Searches
It is possible to report on Successful and Unsuccessful Searches within Supervisor

Opac User Queries

1. Access the Amlib client and go to the Supervisor Module
2. From LibraryMenu select Opacs/OpacQueries
3. Select OPEN from the Query drop-down box
4. Select a **600 – OPEN SEARCH** is the only option
5. Enter the Dates From and To
6. (Optional) Select Y (for Yes) or N (for No) from the Found= drop-down box
7. Y = successful searches, N = unsuccessful searches or blank for all searches
8. Click the F5 Query button
9. A result list will then display
APPENDIX 1: SUPERVISOR SETTINGS YOU MUST SET WHEN YOU USE OPENOPAC

Supervisor Settings

There are some settings in the Amlib Client specifically for the use of OpenOPAC that affects how OPEN is used or set up. Go to Main > Supervisor > Default Screen > Installation > Other Tab > Scroll down to you see these OPEN ...statements. For example, if PINS are required when logging in. The OPEN Web enquiry must be set to ensure the Catalogues are uploaded.

![Supervisor Settings](image)

Explanation of Supervisor > Installation > Other Settings

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>EXPLANATION</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPEN Borrower PIN required (YN)</td>
<td>When logging in if a PIN is required</td>
<td>Y</td>
</tr>
<tr>
<td>OPEN – Default borrower status</td>
<td>When a borrower joins online this is the Status that they will be given, until Library staff has processed the new patron and checked their details.</td>
<td>PEND</td>
</tr>
<tr>
<td>OPEN – Default borrower type</td>
<td>This is the default Borrower type given to a patron when they join online</td>
<td>WEB</td>
</tr>
<tr>
<td>OPEN – Log Search Terms (YN)</td>
<td>This enables a log file to be created of terms being searched by patrons, which can be viewed from Supervisor/Library Menu/Opacs/OpacQueries</td>
<td>Y</td>
</tr>
<tr>
<td>OPEN – Maximum Amount for Borrower owing</td>
<td>Renewals will only be allowed if the borrower owes no more than the amount set</td>
<td>5.00</td>
</tr>
<tr>
<td>OPEN – Maximum overdue days for item renewal</td>
<td>Renewals will only be allowed if the item is no more than the amount of days overdue set</td>
<td>10</td>
</tr>
</tbody>
</table>
OPEN – Only display RESRET memos when item is at collection location (YN)

If a reserve is placed, then a memo will be placed on the Borrower’s details, when it’s ready for collection at the chosen Location

OPEN – Reserve on loan items only (YN)

If set to Y - A Reserve can only be placed on items that are currently on loan and not available on the shelves.

OPEN Web enquiry enabled

** IMPORTANT : Ensure this setting is set to Y before you begin to use OpenOPAC - any new Catalogues/Stockitems you upload/add will never appear in OpenOPAC, as the update tables will not be created until this is set to Y - even if you try and upload changed catalogues

This indicates that OpenOPAC is in use. Therefore it enables Open Transactions service, so that Catalogues and Stockitems are automatically transferred to the OpenOPAC for searching

Supervisor – Installation – Installation Menu – Choose Location – Other - Valid for....settings

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>EXPLANATION</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location is Valid for Holdings</td>
<td>Location is one that is used for Stockitems. If set to N then there will not be any results on the Holdings in OpenOPAC – just the Catalogue maybe found</td>
<td>Y</td>
</tr>
<tr>
<td>Location is Valid for OPAC Enquiries</td>
<td>Location is one that is available for OPAC searching. If set to N, there will be no records found for this location. For example some sites may want the Administration Items to be not valid for OPAC</td>
<td>Y</td>
</tr>
<tr>
<td>Location is Valid for Registrations &amp; Circulation</td>
<td>Location is one that can be set for a Borrower when joining the Library and one that can have Loan Parameters set. If set to N, the Location will not be a Collect Location for Reservations</td>
<td></td>
</tr>
</tbody>
</table>
APPENDIX 2 - COOKIES

By using this service, you agree that certain cookies are placed on your device.

You intend to make use of a web based service that is offered or powered by OCLC EMEA B.V. and its subsidiaries ('OCLC'). These web based services make use of certain cookies. This page intends to inform you about these cookies. To find out more about cookies in general, please visit www.aboutcookies.org. If you are interested to read OCLC’s comprehensive privacy policy, please check the Website

Use of Cookies:

Cookies are small text files that are placed on your computer by websites that you visit. They are widely used in order to make websites work, or work more efficiently, as well as to provide information to the owners of the site. The table below explains the cookies OCLC services used and their purpose

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Necessary</td>
<td>ASP.NET_SessionId</td>
<td>Cookie containing an encrypted string of saved information about the searches that are current (page number, amount of items found, selected filters etc). This cookie cannot track your browsing activity. The cookie is deleted when the browser is closed or automatically after 20 minutes.</td>
</tr>
<tr>
<td>Necessary</td>
<td>OclcCookieConsentAsked</td>
<td>Cookie that stores value to recognise if the user of this site has agreed to store cookies on his/her computer. This cookie cannot track your browsing activity.</td>
</tr>
<tr>
<td>Functionality</td>
<td>OclcRememberLogin</td>
<td>Cookie that contains the barcode of the last logged in patron. This cookie will be removed if the checkbox ‘remember me’ is cleared.</td>
</tr>
<tr>
<td>Functionality</td>
<td>OclcJavaScriptWarning</td>
<td>Cookie for not reminding users that they don't have JavaScript enabled. In other words: this cookie is only active if the user turns off JavaScript.</td>
</tr>
<tr>
<td>Functionality</td>
<td>OclcCurrentCulture</td>
<td>Cookie that is only created if the current regional settings have been changed (the little flag symbol on the top right of the screen). The cookie contains the name of the current culture (eg: en-AU).</td>
</tr>
<tr>
<td>Necessary</td>
<td>ASPXAUTH</td>
<td>This cookie is essential for saving user log in information. This cookie cannot track your browsing activity. The cookie is deleted when the browser is closed or automatically after 20 minutes or after logging off.</td>
</tr>
<tr>
<td>Third-party</td>
<td></td>
<td>Depending on the provider of catalogue information that your library has chosen, these cookies contain information about the cover image, review or rating information etc.</td>
</tr>
</tbody>
</table>
APPENDIX 3: LANGUAGE CONTROL OF BROWSERS VIA IIS SETTINGS

To control the language setting of all your browsers in your institution/library who are accessing the OpenOPAC, you will need to change 2 settings in IIS [Internet Information Services manager]

1. Open IIS7
2. Highlight OpenOPACGui in your sites folder on the left

3. Select **Net.Globalisation** from the ASP.NET box under **OpenOPACGui** home Page

4. There will be a drop down menu besides **Culture** and **UI Culture**

5. Change both of these to **English (Australia) (en-AU)** and then select **Apply** in the top right hand corner.

This will ensure that the flag in the top right hand corner of your browser when you access the OpenOPAC will always be the Australian flag. This setting appears to affect Chrome, Firefox and IE.
APPENDIX 4: FORCING COMPATIBILITY MODE IN IIS7

If OpenOPAC is opening in Compatibility Mode when using Internet Explorer it can be turned off via IIS. This is recommended if external users are accessing the website and having Compatibility Mode issues.

IIS 7 and IE 7 -9

1. Open IIS [ Internet information Service Manager]
2. Highlight OpenOPACGui
3. Select HTTP Response Headers from under OpenOPACGui home page

4. Select Add on right –top hand side

5. A pop-up box labelled Add Customer HTTP Response Header will appear

6. Type in X-UA-Compatible In the Name field
7. Type in IE=8 Value field
8. Then select OK
9. This will cause IIS to open in Internet Explorer to display OpenOPAC as if it was Internet on Explorer 8.
IIS 7 and IE 10 -11

1. Open IIS [Internet information Service Manager]
2. Highlight OpenOPACGui
3. Select HTTP Response Headers from under OpenOPACGui home page

4. Select Add on right –top hand side

5. A pop-up box labelled Add Customer HTTP Response Header will appear

6. Type in X-UA-Compatible in the Name field
7. Type in IE=EDGE Value field
8. Then select OK
9. This will cause IIS to open in Internet Explorer to display OpenOPAC with compatibility mode turned off [Warning Edge is sometimes unstable and is considered the setting for non-production sites, if you have any issues using this setting, then try IE=8 as the value instead]
APPENDIX 5: TO HAVE A PUBLIC (EXTERNAL) FACING OPENOPAC

So that your OpenOPAC can be accessed from a webpage [publicly] such as a council site or maybe a school website, there are two choices depending on how your network is set up, what is accessible and what is not and what your institutions preferences are.

OpenOPAC can be installed anywhere on your Network, it does not need to be installed on your Amlib server or even on an Internal server, as long as OpenOPAC has access to the Amlib databases that is all that is required for it to run. Some clients will install this program on a Web-Server or in a De-militarized zone [DMZ] so it can be accessed by all anywhere. While others prefer to have their own internal set up.

If it has been installed on an Internal Server that has other important resources on it that you don’t want public to access, but is fine for library to use. Then we suggest you set up a second install of OpenOPAC on a Web-server that can be accessed by the public.

If you want to set up a second install Of OpenOPAC for this purpose, so they can be accessed publicly on a council or school web-page – see point 2

1. If installing on a web-server or in a De-militarized zone (DMZ) only

1. Install OpenOPAC on a web server or in a De-militarized zone (DMZ)
2. Install it on a different port from the default HTML port 80 - such as port 81
3. Ensure you put in the correct Hostname for this webserver when installing for the Hostname
4. Ensure that port 1433 is open on the webserver [for two-way traffic] – so it can access the Amlib databases – this is the only access OpenOPAC needs (everything else can be locked down and not accessible)
5. If using an enrichment provider such as Amazon.com or Syndetics etc. You will need to ensure that this web-server allows access to these sites by either adding them as exceptions to the firewall rules or add them as trusted sites. Otherwise images and content will not appear.
6. Also either have pop-up blockers turned off or sites such as www.amazon.com or http://www.syndetics.com/ enter them as exceptions to the pop-up blocker rule or add as trusted sites
2. If this is a Second Install of OpenOPAC - You will need to do the following

1. Install another OpenOPAC on a web server or in a De-militarized zone (DMZ)

2. Install it on a different port 83 to your internal one

3. Ensure you put in the correct Hostname for this webserver when installing for the Hostname

4. Ensure that port 1433 is open on the webserver [for two-way traffic] – so it can access the Amlib databases – this is the only access OpenOPAC needs (everything else can be locked down and not accessible)

5. If Library is using an enrichment provider such as Amazon.com or Syndetics etc. You will need to ensure that this web-server allows access to these sites by either adding them as exceptions to the firewall rules or adding them as trusted sites. Otherwise images and content will not appear.

6. Also either have pop-up blockers turned off or sites such as www.amazon.com or http://www.syndetics.com/ enter them as exceptions to the pop-up blocker rule or add as trusted sites

7. Then configure it the same as their internal one was configured 6. Load all catalogue etc….. 7. This new URL can put as a hyperlink on their council /library website that will go straight to OpenOPAC – giving them public access.
APPENDIX 6: CUSTOMISING COLOURS

For setting colours in OpenOPACS - to match your logo and colours - creating a new Theme

To get your correct colours from your logo or banner

1. Take screenshot of your Logo
2. Open it in Paint.NET or Paint, use the colour picker, hover over the colour you need and write down its red, Green and Blue Values
3. Then go to the site below using these numbers for each colour you want to use, to get the HEX value you will need to enter into OpenOPACS
4. Often you need shades of these main colours to blend into your theme and as there are so many to choose from, you may like to use the other site below that gives you the matching shades of the HEX values you want to use.

This is great site to get the Hex values if you know the Red, Green and Blue values of a colour

http://www.rgbtohex.net/

This site is great once you have the HEX value to get matching shades of your school colours.

http://www.color-hex.com/color/06513d

If your logo is NOT a rectangular in shape

1. You will need to create a NEW Logo that is 340 pixels x 115 pixels.
2. The easiest way to do this is to first open you LOGO in Paint.NET or Paint
3. Then select ‘new’ and create a new image, setting the size you need it to be [340px X 115px]
4. Go back to your original Logo and select sections you want on the New logo, copy and paste them onto the new logo canvas [you may need to re-size them a little to fit]
5. Place all the parts of the logo you want to use, in this way until happy with result. [You may need to add some background colour if logo image does not fill entire space].

Save file in a .GIF, .PNG, or JPG format and upload via the configuration screen for administrators.
APPENDIX 7: CUSTOMISING A HOME PAGE

The Home Page can be used to include:

- A customised image and/or a Location map
- Details and information about the library – for example:
  - Location of branches
  - Opening hours
  - Contact details
- Relevant Links to useful pages
- Links to Social Media that patrons may be interested – for example Twitter, Facebook etc.

It can be deleted to leave the Page empty if preferred.

This will appear under your Home page before a search is conducted.

**If you wish to use the NEW Front page option:** This needs to be setup when logged in as the Administrator > Configuration > Custom text tab.

Configuration

When logged in as Administrator, configuration settings can be done including colours, visibility, parameters, enrichment content and the Marc Fields in OpenOPAC.

It is also possible to set the Default Text for Terms and Conditions and set up the Home Page Text and picture as required.

Go to My Account and Login. The default Username and Password are:
Username: Administrator
Password: 1234

Steps in the Process

1. Login as Administrator
2. From Configuration, select Custom Text Button
3. From the Home page text section you are able to alter the Text and/or Image

Hint: select View > Show blocks as this will show you where you can sit your text & images, as its HTML coded in the background – you can switch to HTML code by selecting Tools, if you are familiar with this instead.

Change the Image

Copy your chosen image to the OpenOPAC Server in the “inetpub\wwwroot\OCLC Open Frontend\Frontend\Images folder OR take note of where the chosen image will be found

1. Click the existing Image
2. Click Insert Menu and Insert/edit Image
3. Change the Image name to that of the chosen Image or enter the path of the Image in the Source Field

![Image](Images/OldLibrary.jpg)

- **Source**: Images/OldLibrary.jpg
- **Image Description**: Old heritage building
- **Dimensions**: 547 x 341

4. Enter the Image Description (Optional)

5. Enter the Dimensions or keep the existing dimensions of the saved image

6. Click Ok to save

**Changing the Text**

1. Consider choosing View – Show blocks so that you can see the Text areas used by the sample
2. Change the Text to suit your relevant details

3. It is possible to alter the Format and Alignment of the Text for Headings and making the Text Bold, Italic, Underlined etc. and the Heading Style. Use the Format button to use these Tools

4. It is also possible to add different Fonts sizes, as well as Text and Background colour using the menu options from the top next to Formats
5. It is also possible to add URL links using Insert/edit Link. Enter the relevant details and press Ok

6. It is also possible to edit the html directly by accessing the Tools menu/ view Source

See Appendix 1 as an example of the original Source code

**Table Menu**
Use the Table Menu to Insert a Table, Cell, Row or Column.

**Cell**

It is possible to alter Cell properties, and to Merge or Split Cells

**Rows**

It is possible to alter Row properties, insert, delete and copy and paste Rows

**Columns**

It is possible to Delete and Insert columns into a Table
Save the Home Page

Once the changes are changed, ensure the green Save button is selected from the base of the Window.
Source code for Home Page
This can be used to copy back the Source code for the Original page in case the editing does not go to plan...

```html
<div id="MainHomePageWrapper">
  <div id="TextWrapper" style="float: left; width: 50%;">
    <div id="DivLibraries" style="float: left; padding-right: 100px;">
      <h1 id="pageTitle" class="ms-core-pageTitle"><span id="DeltaPlaceHolderPageTitleInTitleArea">Libraries:</span></h1>
      <div class="ms-displayInlineBlock ms-normalWrap"><a id="ms-pageDescriptionDiv" style="display: none;"></a><span id="ms-pageDescriptionImage">&nbsp;</span><span id="ms-pageDescription" class="ms-accessible"></span></div>
      <div id="pageContent" class="pageContent">
        <div id="ctl00_PlaceHolderMain_PageContent__ControlWrapper_RichHtmlField" class="ms-rtestate-field" style="display: inline;">
          Here you can enter information like addresses, opening hours etc
        </div>
      </div>
    </div>
    <div id="DivContacts" style="float: left; padding-right: 100px;">
      <p>Our Library, 1 Reading Street - Library Town</p>
      <p>The opening hours are</p>
      <p>Monday to Thursday</p>
      <p>Friday</p>
      <p>Saturday</p>
      <p>9am to 7pm</p>
      <p>9am to 5.30pm</p>
      <p>9am to 12noon</p>
    </div>
  </div>
</div>
```
<h1 id="pageTitle" class="ms-core-pageTitle"><span id="DeltaPlaceHolderPageTitleInTitleArea">Contacts:</span></h1>

<div id="ctl00_PlaceHolderMain_ctl00_ContactsDiv">

<div id="ctl00_PlaceHolderMain_ctl00_ContactsField_label" style="display: none;">Contact Information</div>

<div id="ctl00_PlaceHolderMain_ctl00_ContactsField__ControlWrapper_RichHtmlField" style="display: inline;">

<p>Our Main Library<br />Library Town - 3242<br /><a href="mailto:info@ourlibrary.com">info@ourlibrary.com</a></p>

<p>Our Mobile Library<br />Library Bus - 929055<br /><a href="mailto:info@ourlibrary.com">info@ourlibrary.com</a></p>

</div>

</div>

<div id="DivFollowUs" style="float: left;">

<h1 id="pageTitle" class="ms-core-pageTitle"><span id="DeltaPlaceHolderPageTitleInTitleArea">Follow us:</span></h1>

<a class="button2 button2-newsletter" href="http://www.ourlibrary.com/ENewsletter.aspx" target="_blank">Newsletter</a><br />
<a class="button2 button2-facebook" href="http://www.facebook.com/pages/OurLibrary" target="_blank">Facebook</a><br />
<a class="button2 button2-twitter" href="http://twitter.com/#!/OurLibrary" target="_blank">Twitter</a></div>

</div>

</div>

</div>